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1. Introduction
The Scholar’s Toolbox is a library of primary source docu-

ments for four versions of A Course in Miracles.  They consist of 
digitized photocopies of original manuscripts called facsimiles and 
word processor file copies which are machine searchable which we 
refer to as e-texts.  To a substantial extent these are all cross-referenced 
making it relatively easy for the most part to quickly locate “the same 
page” across editions and versions. 

The Notes themselves are not ‘searchable’ and originally 
contained no referencing, not even page numbers or dates.  While it 
has a few large and many very small differences, The Urtext e-text is 
mostly very similar to the Notes and being searchable, can be used to 
locate specific passages in the Notes within a page or two, most of the 
time.  The same is true for the other facsimile manuscripts, their 
corresponding e-texts are largely reliable enough to quickly and easily 
locate material in the unsearchable facsimiles. 

This collection not only includes all available primary source 
material we know of, it provides a common reference grid to facilitate 
cross-referencing. 

There are many thousands of differences between the versions 
and these tools were created to make it relatively simple to compare 
any passage in any two versions to identify variant readings.  The basic 
technique is simply to get copies of the two on the screen at the same 
passage.  Easy in theory, a bit more complicated in practice. 

This tutorial is designed to provide simple and effective 
techniques using freeware (free software) to quickly and effectively 
find any ACIM passage in the facsimile copies of the Shorthand Notes, 
or any other version, provided it’s actually there.  The basic technique 
involves two steps: 

1) find the passage you seek in the searchable e-text of any 
version, and note the “chapter/section/paragraph” reference or 
manuscript page number there, 

2) using those references, you can then quickly locate the same 
relative spot in the facsimile copies (manuscript photocopies) which are 
not directly searchable.  While this isn’t hugely complicated, this 
tutorial is provided for those experiencing difficulties or new to this 
kind of software. 

Without such cross-referencing, finding anything in the 
thousands of pages of facsimiles can be very tedious and time-con-
suming. 

As with most tutorials, it works best if you can actually per-
form the operations described while going through this material.  When 
displayed on your screen, unless you have two monitors, however, you 
won’t easily be able to both look at the tutorial and perform the 
described operations.  It can therefore be helpful to print out any 
sections which you wish to reference. 

The techniques outlined here are less for the professional, 
expert, or well-equipped computer lab than for the novice or casual 
user unprepared to invest in specialized software for this application.  
There are ‘better’ ways and there is more expensive software but there 
are also ‘workable’ ways using free software outlined here. 

Because no re-typed copy can preserve all the subtleties and 
handwritten mark-up of the original manuscripts, it is often desirable to 
“check the manuscript” to verify a quote or investigate a variant 
reading between versions.  These tools were specifically created to 
make it easy to do just that. 
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Until one masters Helen’s handwriting, even reading the Notes 
can be difficult without having a typed transcript alongside.  With the 
latter, reading them is easy and one can quickly develop fluency with 
Helen’s handwriting. 

Note: we do not have a complete e-text transcript of the Notes. 
However, the Urtext is close enough, often enough, to make it a very 
useful “map” to the Notes contents.  And, while not 100% accurate, it’s 
the best which is currently available for most of the Notes.  One can 
usually get within a page or two in the Notes from any passage found in 
the Urtext within a few seconds, once you are familiar with these tools.  
The exceptions involve those pages which are missing or out of order. 

Nomenclature 
In 1975 the Foundation for Inner Peace (FIP) published three 

volumes of ACIM, 1) Text, 2) Workbook and 3) Manual for Teachers. 
In 1976 a fourth volume called Clarification of Terms was added as an 
appendix to the Manual.  It is included here under its original name, 4) 
Use of Terms as a stand-alone volume.  Parts of the FIP edition are 
heavily edited. It’s about 60,000 words shorter than the Urtext in the 
Text volume alone. 

Four historical scribal versions of the ACIM Text volume are 
known to exist, and a fifth, the Thetford Transcript is presumed to exist 
but has not yet become available.  To make life confusing, these 
versions have gone by many different names over the years.  We are 
using the oldest and most original names we’ve been able to trace, 
generally those used by the Scribes themselves.  They are: 

1) Shorthand Notes 

2) Thetford Transcript (little if any of this has surfaced) 

3) Urtext (some portions of which may be the Thetford Tran-
script) 

4) Hugh Lynn Cayce or HLC version (Text volume only) 

5) Nun’s Version or FIP Abridgement 

The Workbook and Manual for Teachers and Use of Terms 
volumes of ACIM exist in three versions; there is no HLC for those 
volumes.   

Following the initial publication in 1975-76, further material 
was scribed by Helen Schucman which is included here as volumes 
four through seven.  These are called 5) Psychotherapy, 6) Song of 
Prayer and 7) Gifts of God.   With the exception of Volume 7, Gifts of 
God, for which no Notes manuscript has emerged, we have both Notes 
and Urtext manuscripts for these volumes.  FIP has also published 
edited versions of these volumes in one way or another over the years. 

Extra-canonical material 
In addition to this material widely regarded as “canonical” and 

“part of the Course” there are some additional manuscripts from the 
scribal era, including “personal material” in the Notes and Special 
Messages.  The manuscript facsimiles and some e-texts of this material 
are included.  There is also the Preface both in the original Notes 
manuscript and the heavily edited FIP version. 

This is not the total collection of original manuscript copies 
prepared by the Scribes, it is simply all that is presently available. 

The e-texts 
When they first emerged as photocopies, these primary source 

documents were difficult to search.    Over time “e-texts” emerged for 
the HLC and Urtext which were highly accurate in places, but due to 
inadequate proofreading, were sometimes very inaccurate.  The need 
was apparent both for a standard reference system for all versions and 
of course, accurate e-texts. 
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Both these issues have been addressed to some extent in this 
compilation, and to use it you will need to understand a few basic 
elements. Due to the fact that there are differences in sequence and total 
length across versions, a standard common reference system is rather 
problematic. 

For the Text volume, where most of the editing changes occur, 
the Scribes introduced a reference system in the 1972 HLC.  The whole 
of the Text as it was abridged at that time was divided into 31 chapters 
with up to a dozen section divisions within each chapter.  One could 
thus “reference” anything in the Text by chapter number, section 
number within a chapter, and paragraph number within a section.  This 
is directly analogous to the time-tested “chapter and verse” system in 
the Bible which has proven so useful for that book.  In 1975 FIP 
modified some of the chapter and section breaks and names but largely 
preserved that system.  None of the earlier manuscripts are divided up 
that way.  In the Text, there are really no divisions in the Urtext and 
Notes, it’s just one long continuous document. 

The Reference Grid 
For cross-referencing purposes then, we retro-fitted the HLC 

chapter and section divisions to the earlier manuscripts as closely as we 
could.  For the most part, although the HLC is missing some 50,000 
words found in earlier versions, except at the end of chapter one, it has 
the same sequence.  With that exception then, the HLC break points 
identify the same material in all versions.   

The chapter and section “grid” has been applied to all versions 
and except for some spots in the very early chapters of the Text, it will 
generally land you within a page or two of the spot you seek in any 
version.  At the very least, instead of having to search a thousand pages 

or more for a quote, you only have to search a page or two with this 
system. 

Due to the fact that paragraph breaks were often changed from 
version to version, paragraph numbers do vary between versions.  
However, they don’t vary all that much for the most part.  So while 
chapter 10, section 2, paragraph 5 in one version might be paragraph 4 
or paragraph 6 in another, it is rarely off by more than one or two.  So 
it’s still useful for narrowing the search. 

A second reference system consists of manuscript page 
numbers.  In our e-texts we’ve either preserved the exact pagination of 
the original manuscript or marked the original manuscript page breaks.  
Thus you can always quickly tell in the e-text what the manuscript page 
number is.  Our e-texts also preserve the paragraph breaks of the 
manuscripts of which they are copies, so e-text references by page or 
paragraph will work exactly on the manuscript facsimiles. 

Accuracy 
While all the e-texts have been proofed, they have not been as 

thoroughly proofed as we’d like.  There are some residual typos but for 
the most part they are few, far between, and minor in nature.  The work 
of proofreading is on-going and should you discover any such typos, 
please let us know. 

The methods outlined in this tutorial are by no means the only, 
nor even the best ways of viewing two documents on one screen.  It’s 
not a topic on which I can claim much expertise; I use dual-monitor 
computers for almost everything.  These techniques are merely simple, 
easy to explain, workable, and can get you started quickly with your 
first side by side look-up. 
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2. The Main Menu 
 

This is the Main Menu which 
should load automatically when the CD 
is inserted. 

The first item is an Introduction 
written for first-time users.  The second, 
the Site Map is primarily for advanced 
users who want a more direct, low-level 
way to examine the directory structure. 

The items in the upper menu box 
take you to the Primary Source 
Documents sub-menus for locating and 
viewing any of the files. The third item is 
primarily for advanced users, and takes 
you to a single-level menu showing all 
the available source documents on one 
screen..  There is so much data on that 
menu, and it is printed so small, it’s not 
recommended for beginners.  It can be a 
bit overwhelming. 

The Documentation Menu is where 
various kinds of descriptions, 
explanations, this tutorial, and other 
background information are provided. 

The third item takes you to the on-line Concordance discussed in greater detail later in this tutorial.  The fourth item is for 
those who wish to order the 5 CD set of original high resolution scans of Helen Schucman’s Shorthand Notes. 

Figure 1a The Main Menu 
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3. The Versions  Menu 
This is the Versions menu which you 

reach by clicking the first item on the 
Main Menu. 

The Volumes menus are basically the 
same except they organize the source 
files by Text, Workbook, Manual etc., 
rather than by version. 

In the Versions menu you see 
thumbnails and labels for the five distinct 
versions of ACIM for which we have 
source material. 

Below that are listed the 11 different 
volumes into which we’ve divided the 
total body of data.  Volumes 1, 2 and 3 
correspond to the familiar FIP three 
volumes, but as you see, there is 
additional material, some of which FIP 
has recently begun to include with the 
three earlier volumes. 

To select any volume of any version 
with this menu, simply select the version 
you’d like to check.  Let’s start with the 
Urtext, third from the left, and click either 

on the word “Urtext” or on the thumbnail 
page image itself. 

The next screen shows what we’ll see: 

Figure 1b: The Primary Source Documents Versions Menu 



6 The Three Primary Source Menus 6 

 6

4. The Version-Specific Menus 
Each version has its own menu, 

this one is typical. We see there are 
two columns of identical volume 
names, some are underlined in dark 
type and some are in very faint 
type.  Those in faint type are 
volumes not present in this version.  
That means either they never did 
exist, haven’t been created yet, in 
the case of e-texts, or exist but are 
unavailable to us.  The volume 
names in dark type are hotlinks.  
Click on the name of the volume 
you want to view. 

If you want to see the facsimile 
images of the original manuscript 
pages, click on the volume you’d 
like to see in the left-hand column.  
If you want to search an e-text of 
the same material, click on the 
volume you want in the right hand 
column. 
Regardless of which version you 
chose from the previous menu, you 
will see something very similar to 
this menu. 
 

Figure 1c: The Primary Source Documents second tier version-specific Menu 
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5. The Volume-Specific Menus 
For convenience, all the 

source files are listed 
according to the canonical 
or extra-canonical volume 
in this menu system. 

 
Clicking on any menu 

item reveals a second 
menu showing the source 
material available for that 
particular volume

Figure 1d The Volume Specific Menu 
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6. The Primary Source Global Menu 
The Primary Source Global Menu, looks 

something like this image in Figure 1e.  It’s called 
“global” because all the source files are listed here. 

Until you’re familiar with the material, this can 
be a bit overwhelming and confusing.  The 
previously illustrated two-tier menu systems are a 
simpler, if a bit slower, tool which accesses the exact 
same material. 

The versions available on this CD are listed 
horizontally, 1 through 6 while the volumes within 
each version are listed vertically, 0) through 10).  
Because each version does look a bit different, we 
included “thumbnail” images to assist quick 
identification. 

Where they are available, for each volume of 
each version there is an “(A)” file which is a 
facsimile of the original manuscript, and a “(B)”file 
which is a searchable e-text.  You will see that we do 
not have both for every volume of every version, but 
we have at least one for each volume. 

 

 

 

                                                                                     Figure 1e The Primary Source Documents Global Menu showing all source files for all 
volumes. Pale blue indicates documents we believe do or may exist but for which we’ve been 
unable to obtain copies. 
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7. Comparing two documents 
In General … 

The Menu systems are a convenient access point to lo-
cate any single volume of any single version.  Within Acrobat 
Reader you can load any two of the PDF files and “tile” them 
horizontally or vertically side by side.  This is one of the best 
ways I know to get both the facsimile and the e-text of any 
volume open on a single screen to the same spot for direct 
comparison. 

Accessing Acrobat Reader from within the browser 
usually brings up the PDF within a browser window by default, 
and it doesn’t allow you to open a second PDF file in the same 
window for tiling and side by side comparison.  With Firefox 2 
browser it is very simple to toggle the browser to call PDFs in 
a separate Acrobat Reader window such that you can load any 
number of PDF files for tiling.  With the browser set that way, 
to open Acrobat Reader in a separate window, you can actually 
just quickly click on the two files you want and they both open 
up in a new Reader window. 

I highly recommend using Firefox 2 and adjusting it to 
open Acrobat Reader in a separate window.  It is much faster 
and makes it easier to display two or more files at once.  For 
details on how to modify PDF display, go back to the Main 
Menu, click on Documentation, and then select Speeding 
up Acrobat Reader and displaying multiple files. 

If you don’t want to change your browser’s PDF dis-
play behaviour, there are some workarounds. I’ve yet to figure 
out any other really easy way to bring up two different versions 
for comparison using the web browser on a single monitor.  
However, it is not particularly difficult to do so using two sepa-
rate windows, either browser windows or Acrobat Reader win-
dows, and the operating system’s “tile” function, as explained 
below. 

One way to do it in the Firefox browser, which is highly 
recommended for this material, is to load two Firefox win-
dows.  You can do that from the top left corner of the first 
Firefox window by clicking on File => New Window.  Once 
loaded, look to the taskbar which shows all open windows at 
the bottom of your screen. Right click on the Firefox task (or-
ange circle with the little blue fox in it) and then click on Tile 
Horizontally. Your screen is now split horizontally between the 
two Firefox windows and you can load any of the other files in 
the second window so you can compare side by side. 

To load a file into a Firefox window from within Fire-
fox use the File command in the top left corner again, and then 
Open File.  You then have to browse to the directory (folder) 
you want and click on the particular file you wish to open.  
This will get you any two PDF files side by side horizontally.  
To get more of the text on the screen and fewer toolbars, right 
click on the second horizontal toolbar band from the top and 
toggle the Bookmarks and Navigation toolbars off by left 
clicking them. When they are checked, that means they are dis-
played, when the check mark is gone, that means they are not 
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displayed.  (see Figure 2a) When you need to turn them back 
on, repeat that procedure.  By toggling the toolbars off you get 
more of the actual text on the screen, which is useful when you 
wish to display more lines of the document. 

When you’ve done this, the result looks something like 
the next screenshot in Figure 2a.  In that screen shot I’ve 
opened the Use of Terms in the Urtext facsimile and the Urtext 
e-text for the same volume. The exact same thing can be done 
with any two files you wish to display at once, however.

Figure 2a Horizontally 
tiled Firefox windows 
with the Urtext facsim-
ile on top and the 
Urtext e-text on the 
bottom.  
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With a single monitor, 
you can display two 
documents horizon-
tally (seen on left) or 
vertically (see next 
figure). 
 
The choice will de-
pend on the nature of 
the material you’re 
viewing and just what 
you want to do with it. 
 
See below for precise 
instructions in how to 
get these views on 
your screen. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2b Horizontally split screen (1162 X 864 pixel resolution) with toolbars closed to maximize text window size.
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In the horizontal view,  
(previous page) you 
see that you can keep 
the Bookmarks side-
bars opened and still 
have the text quite 
large enough to read.  
In the vertical tiling, 
(on left) you really 
need to close the 
Bookmarks Sidebars 
to get a good view of 
your document. 
 
The vertical tiling gets 
more of the page on 
the screen while the 
horizontal gives you 
less of the page, but 
complete lines are lar-
ger and more legible, 
and of course you can 
keep the bookmarks 
open.  Needless to say, 
the bigger your moni-
tor, the better. 
 
 
 

Figure 2c The same windows as in previous view vertically tiled with bookmark sidebars closed 
and text size reduced on right side window.
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In Detail… 
1) From the main menu select the first file to open.  In this example we’ll use the Use of Terms, and 

compare the Notes to the Urtext e-text. Clicking on the Use of Terms under the Notes heading 
will bring that file up in Acrobat Reader within Firefox. 

2) In the top left corner of the Firefox toolbar click on FILE, then New Window.  When the new 
window opens click Open File 
and “browse” to the file you want.  
(see figure on left) We’ll go to the 
Urtext e-text folder and find the 
Use of Terms. 

3) Clicking on any of the PDF files 
will cause it to be displayed in the 
new window. To split the screen 
between the two windows look to 
the Taskbar at the bottom of your 
screen. We’re interested in the or-
ange ball with the little blue fox as 
shown below.  Right click on that 
and see next illustration. 

 

 

Figure 2d Window for browsing files in Firefox 

 

 

 
 

Figure 2e Windows Taskbar on the bottom of the screen (This example from Windows XP)
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Having right clicked on the 
Firefox box in the Taskbar which 
is that bar along the bottom of your 
screen, you’ll see this (left).  We will 
select Tile Horizontally which will 
give us the following (bottom left 
figure): 

 
Figure 2f Tiling from the Taskbar 

 

Now we have our Notes image 
on the top window and our e-text 
image in the bottom window.  How-
ever we have lost almost half the 
area of our screen to the various 
toolbars. 

 

Turn to the next page to see 
how to close and re-open the 
various taskbars. 

 

 

 

 

 

 
Figure 2g Horizontally Split Screen 
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These three images are of the top left 
corner of the screen when Firefox has loaded 
Acrobat Reader. The three screen shots show 
how to toggle toolbars off. By right clicking 
on the second line of the screen, just beside 
“Help” we see that little popup box with the 
words “Navigation Toolbar” and 
“Bookmarks Toolbar” and 
“Customize.” 

By clicking here we can toggle these 
toolbars on and off.  I’ll toggle them off and 
we’ll see the result in the middle illustration. 

You can see that both the Firefox toolbars 
are gone now and we can see much more of 
our document. 

But there’s still one more toolbar we can 
toggle off, and that is the Acrobat navigation 
bar.  Pressing F8 will toggle it on and off. 

I’m going to do that now, press F8. 

Now you see we’ve got a good deal more 
of our document and a good deal less of the 
toolbars.  They can all be brought back in an 
instant when they are required however. 

To bring back the Firefox toolbars, right 
click the second line and then click on either 
or both the Navigation or Bookmarks.  To 
bring back the Acrobat toolbar, press F8. 

 

Figure 2h Toggling the toolbars to display more text, note how as each “toolbar” is closed, more of the document is visible. 
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8. Locating documents by Browsing 
The other principal way of loading documents into viewing 

software is to browse from Windows Explorer or your favourite 
shell program.  If you are not familiar with Windows Explorer 
it is found in Windows XP by clicking on Start => All 
Programs=> Accessories => Windows Explorer.  With this tool 
you can view the contents of any folder on the CD, or on any 
other storage device on your computer for that matter, and 
click on the one you want to view.  Left clicking will load the 
file into the default program for that file type, but by right 
clicking and then clicking on Open With you can select the 

specific program to use when you wish to use anything other 
than the default application. 

In this screen shot (Figure 3) we see Windows Explorer’s 
view of the CD, in this case it’s disk drive (E:) 

Each of the versions listed on the Main Menu has its own 
directory (folder) and each volume in that version is listed in 
the folder.  Click on whichever one you want to view, much as 
you would from the main menu. 

In this example I’ve clicked “1 NOTES” on the left pane, 
causing each file in that folder to appear in 
the right pane.  This is also set to “details 
view”, which is the only Windows “view” 
that makes any sense to me at all. 

To get the “Details” view click on 
View =>Details on the top bar of Win-
dows Explorer. 

As soon as you left click on any of the 
filenames, that file will be loaded into 
your default PDF viewer which we’re as-
suming is Acrobat Reader 9. 

 
 
 

Figure 3 Selecting files with Windows Explorer 
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9. Basic Searching with Acrobat Reader
Searching with Acrobat is really quite simple once you 

are familiar with it but can be a bit daunting if you’re not.  If 
you’re not, this section of the tutorial points out the basics.  

First you need to load up one of the searchable “e-text” files 
either from Windows Explorer or directly from Acrobat Reader 
or from the menus. The search technique is the same with any 

of them. We just click on the “binoculars” 
icon [ ] up there in the top left corner 
and Figure 4 is what we see. If you don’t 
see the “binoculars” icon see “Configuring 
Acrobat” at the end of this tutorial.  

NOTE: Acrobat Reader, when it is 
called from the Browser through the menu, 
for instance, generally only offers a subset 
of these search options. 

 

Now we enter the character string, 
word, phrase, or anything we think we 
might find in the document, and press 
“Search.”  In this case I’ve decided to look 
for the word “teaching.”  Let’s press 
“Search” and see what happens. 

Figure 4, the “Search” window is opened up on the left.  Again, I’m just showing the top half of the screen. 
Note the “Arrange Windows” button in the top left.  When using the search window you sometimes will 
have to click that to get everything lined up on your screen. 
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What happens is a list of 
all instances of that search 
string appears in the search 
sidebar on the left, in this case 
all instances of the word 
“teaching.”  If we click on 
any of one, the main window 
on the right scrolls to that 
point in the Text. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 5, the search shows each instance of a match in the left hand sidebar and highlights the first one in 
the right hand text window. 
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Note that you can resize the window so 
you can see more of the context, as in this 
screenshot: 

Now you can scan through the list of 
“hits,” and when you click on any one, the 
right hand text window will scroll to that 
spot in the text.  Go ahead and try a few.  
In this search tool we are not limited to a 
single word, as with the Concordance, but 
unfortunately we can’t get a “print-out” of 
our hits.  And with the bigger files, 
Acrobat’s searching is very SLOW!! 

But you’ve got to admit it is simple!  
So for the casual user, looking up some-
thing only now and then, it is probably 
adequate most of the time for locating a 
particular passage.  So long as you re-
member any single word accurately, you 
will likely find it with this tool with mod-
erate ease.  With our cross-referencing, 
one you find it in any version, it’s usually 
easy to locate it in any other. Generally, 
the more words you remember accurately, 
the faster your search. 

Figure 6, resizing the “search” window to see more context. 
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10. Quick Search 
The simplest way to search with Acrobat is with the 

“Find” button on the right of your toolbar (Control + F).  Enter 
the word you wish to find and Acrobat will jump to the next 
instance of that word.  This is fast but if it’s a common word 
there are too many hits. With more common words I prefer to 

have the whole list in the second window (see Basic Search) 
than jumping through each instance in the whole text body. 

There are times, however, when this tool is best.  It is 
so simple that I really don’t think you need a screenshot. 

11. Advanced Searching in entire directories (folders) 
You may have noticed that when you click on the “binocu-

lars” [ ] icon to start the search, there are two options in that 
new search window: (Figure 7)  

Where would you like to search? 
 O In the current PDF document 

 O All PDF Documents in: 

 
Below that, as shown on the left, 

there is a “browse” dialogue box in 
which you can point to any directory 
on your computer or local network by 
clicking on the “v” to the right of “My 
Documents” as shown in Figure 7.  
The “e-texts” directories in our distri-
bution are where all the searchable 
files are, and if you select that direc-
tory in this dialogue box, your search 
will cover all volumes of ACIM, 

rather than just the currently displayed one. 

This can be slow, and the Concordance is a much quicker 
way to search all seven volumes, but still, this does work, and 
can be useful, so we’ll show you how to do it. 

The main difference between this way of searching and the 
one we just did lies in where the search extends.  So far our 
searches have been confined to a single file, or single volume 
of a single version. With this tool, we can extend our search as 
far as we wish. We enter our search parameters (what we want 
to search for) the same way as before, and then select the di-
rectory (folder) we wish our search to extend through.

Figure 7 Searching Multiple 
Documents       
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12. Advanced Search (other options) 
As you can see in Figure 8, you can select additional searching options, such as “exact 

word or phrase” or “Any of the words.”  You can also make the search case-sensitive, match 
whole words only, so that a search for “not” doesn’t also find “nothing.” 

One little caution is in order.  When a footnote falls within a phrase, it causes problems.  
We’re working on a solution for this but at the moment Acrobat will not find a phrase if a footnote 
superscript indicator falls within it.  It’s ok if the footnote is at the end or the beginning of the 
phrase, but if it’s in between words of the phrase, it effectively hides that phrase.  This is not desir-
able, and as I said, we’re working on a fix.   

This is one of several things which can cause a search for a precisely accurate phrase to 
fail.  Generally if you start dropping words from either end of the phrase you’ll eventually find it. 

Acrobat has additional highly advanced search features, including “Boolean” searches 
which are beyond the scope of this tutorial to explore.  Acrobat Help has a good article on their use 
and a web search for “Boolean” will locate a great deal of additional information. 

Our basic goal here is to locate a passage we know in the Urtext e-text so as to find a refer-
ence which we can then use to locate the same passage in the Notes.  This isn’t a course in the 
tools of sophisticated textual analysis. 

As noted previously, when Acrobat Reader is displayed within the Browser window, as is 
the installation default when using the menu, there is only a sub-set of the search capabilities 
available.  You have to load Acrobat Reader directly or click on one of the PDF files in Windows 
Explorer to enable the full Advanced Search capabilities outlined here.  Or you can reconfigure 
your browser to load Acrobat in a separate window.  (see Section 8, page 9 if you wish to do this) 

 
 
 
 
 
 
 

Figure 8 Advanced Search 
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13. Using Acrobat to find the reference in the Notes 
We’ve just learned how to use Acrobat to search for words 

and phrases.  Now we’re going to search the e-text of the 
Urtext to locate the reference needed to find the same spot in 
the Notes.  So load up Acrobat with the Urtext e-text as ex-
plained in the first section, and then click on the “binoculars” 

[ ] to start a search.  The search string for this example will be 
“teach only love.”  If we load the right volume we’ll see the 
screen on the left.  Our search string is highlighted in both the 
sidebar (left) and the text window (right of screen) and we need 
merely read our reference off from the beginning of the para-

graph.  We can see the paragraph reference is:  

T 6 B 14. 

We can also see two other instances of the 
phrase “teach only love” in the sidebar and we 
can check those out, but this is actually the one I 
was looking for. 

If you don’t find it, of course it’s possible it’s 
in another volume.  Previously we showed you 
how to search across multiple volumes.  Be ad-
vised that these searches can be very slow in Ac-
robat.  That’s where the Concordance, discussed 
later, comes in.  It’s also possible that punctua-
tion or a footnote makes a correctly remembered 
phrase appear slightly differently.  

 

 

 

 

 

 

 

Figure 9 Finding our reference in Acrobat 
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14. Locating the Reference in the Notes 
Now that we have found the 

chapter, section and paragraph 
number, we open the Notes PDF 
file, which starts off looking like 
this screen shot.  We want chapter 
6, section B, paragraph 11, so 
I’ve highlighted chapter 6 in the 
Bookmarks sidebar by putting the 
pointer over it. 

Clicking on Chapter 6 brings us 
to the page in the Notes where 
chapter 6 begins. 

Clicking the “+” sign to the left 
of the Bookmark for Chapter 6 ex-
pands the Bookmarks list to show 
sections, and then I’ll click section 
B, and that takes us to the next 
screen shot. 

 

 

 

 

 
Figure 10 Clicking on the Bookmark for Chapter 6 takes us right to the start of Chapter 6 indicated by the yellow “sticky note.”
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    The yellow note points to the 
exact spot where section B be-
gins, and now we have to go 14 
paragraphs forward. That is ac-
tually unusually long.  Only a 
few sections are more than 12 
paragraphs. 

At this point it is useful to be 
able to display both the Notes 
and the e-text of the Urtext so 
that we can precisely count and 
compare paragraph by para-
graph. 

The best tool for this is a sec-
ond monitor, but we can do it 
with just one.  We practiced do-
ing this with two Firefox win-
dows in section 3, and now we’ll 
use another technique. 

Load the two PDF files you 
want to view directly into Acro-
bat Reader, in this case the 
Notes and the e-text of the 
Urtext, and then click on Win-
dow => Tile => Horizontally.  The 
result appears in the next screen 
shot.  

Figure 11 Using Bookmarks to jump to a section break
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Now, with the two copies side 
by side, the Notes on top here 
and the e-text of the Urtext be-
low, we can scroll through both, 
paragraph by paragraph, until we 
get to the point we are seeking. 

Remember that the yellow 
“sticky notes” can be moved or 
made to disappear when they 
obstruct our view of the text. 

Note also that the paragraph 
breaks in the Notes and the 
Urtext are usually (though not 
always) the same, and are usu-
ally clearly marked with a large 
indentation.  This makes it fairly 
easy, usually, to count para-
graphs. 

We can also count Urtext 
pages, and advance the Notes by 
the same number of double 
pages or twice the number of 
individual pages, and arrive 
roughly at the same point.  

 
Figure 12 The Notes and the Urtext  e-text viewed as horizontal tiles 
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  Hey! We found it just by 
counting paragraph indentations.  
I have shaded in the section here 
to point it out to you.  It’s not as 
easy to read the screen shot as it 
is on the actual screen. 

You will notice also that on 
the right hand page here, the 
paragraph break is marked with 
the chapter, section and para-
graph number in the left margin 
and the Urtext manuscript page 
number is marked in the right 
margin. 

Since the Tutorial was 
prepared I have added paragraph 
references in all the Notes 
volumes except for the 
Workbook where only lesson 
and Urtext page numbers are 
added.  These can be directly 
searched with Acrobat Reader’s 
FIND and SEARCH functions, 
which greatly speeds up the 
process of locating particular 
passages. 

Figure 13  Aligning the e-text of the Urtext with the Notes to locate and compare the passage.
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15. Using Acrobat to Read Out Loud 
Now we get into some really fun 

stuff.  We can get Acrobat Reader to 
read out loud from the e-text while 
we follow along in the Notes. 

Click on View => Read Out Loud 
=> Activate (see below for shortcuts) 

If you reformat your tiled win-
dows roughly as shown here you can 
get two whole pages of the Notes 
visible and then scroll through the 
smaller e-text window for the Urtext, 
highlighting the material there para-
graph by paragraph. This makes it 
easy to get Acrobat to start and stop 
in small bits.  

This is a whole lot faster than 
looking back and forth from one 
document to the other, word by 
word.  It’s also a great way to learn 
Helen’s handwriting, to just have it 
read aloud as you follow along by 
eye. 

Acrobat’s “voice” is far from the 
best voice synthesizer which exists, 
but it is free and it’s good enough  

Figure 14 Acrobat reader configured for reading out loud                                                                                               
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most of the time to be very useful.  You can also use the e-text 
in the Concordance (see next section) and the free voice syn-
thesizer in the Opera Browser to achieve results that are a bit 
easier to control. 

Acrobat Out Loud Keyboard Controls  
If you load Acrobat and then your file, you can use the 

VIEW menu on the top left of the screen in Acrobat Reader 7 or 
8 to activate the Read Out Loud feature.  I can find no way to 
make the VIEW menu appear when Acrobat is called from 
within Firefox however.  The keyboard controls do however 
work, but  you will have to memorize them or refer to this page 
for a reminder. 

Oddly, the keyboard controls are different in Acrobat 7 and 
later versions. Those in versions 8 and 9 are more full-featured.  
Those are the only ones I’m going to describe because Acrobat 
8 and 9 are much better at reading out loud. 

Shift+Ctrl+Y toggles it on or off. 

Shift+Ctrl+V reads to end of page. 

Shift+Ctrl+B reads to end of document. 

Shift+Ctrl+C pause. 

Shift+Ctrl+E stops. 

Acrobat Reader 9 also allows you to highlight or box lim-
ited portions of a page, such as single paragraphs once Read 
Out Loud is toggled on and this very much increases the utility 
of the program for working through the Notes. 

As shown in the previous illustration, if you can get a page 
or two of the Notes visible and in another window an e-text 
version of the same material, getting Acrobat (or any voice 
synthesizer) to “talk the paragraph” makes it much easier and 
faster to read Helen’s Notes until you become fluent with her 
handwriting and shorthand. It’s possible to move through the 
Notes quite quickly and in the process you gain fluency with 
her unique script. 

A better, but more expensive way 
 I use “Text Aloud” software for this purpose which has the 

advantage of a pause button.  Unfortunately it is not free soft-
ware.  Its pause button will sit in a corner of the screen and I 
can highlight and copy anything I can see and Text Aloud will 
read it.  It also has configurable pronunciation so we get a bet-
ter sounding voice. 

I also use two monitors so I have the Concordance e-text in 
my web browser on one monitor and Acrobat displaying the 
Notes on the other and I highlight the portions I want to have 
read and away we go! 

Of course you could also get a friend to just read it aloud 
“human-style.” 

There are several other twists I’ve tried.  One is to print out 
pages and prop those beside the monitor.  Another is to print 
out both versions and put them in a binder on facing pages, so I 
have it on paper in front of me.  And I’ve had Text-Aloud put 
whole chapters on audio CDs so I can sit back and listen on my 
CD player with its PAUSE button.  You could similarly use 
any portable audio player. 
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This, in my view, is by far the best, and its advantages be-
come more apparent the more of this you’re doing.  To check a 
single paragraph is reasonably easy with the techniques shown 
here. To check a whole chapter becomes quite awkward be-
cause you have to keep scrolling the screens and bouncing 
between windows and regulating the “voice.” I find printing 

the material on facing pages is vastly easier to work with and 
easier to mark-up. I just use an orange pencil. 

The purpose here, however, is to show you how to FIND 
material in the Notes using the cross-referencing we’ve put into 
the material.  It is beyond the scope of this tutorial to do more 
than mention the possibility and benefits of rendering the e-text 
in audio.
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16. Using the Concordance for fast searching 
At the URL http://www.execulink.com/~dthomp75/2007/index.htm you will find the MPF On-Line Concordance.  Generally you 

will find the most recent updated version 
on the website. 

A simplified abridged Concordance is 
also available from the CD main menu. 

A Concordance lists every word in a 
document along with its precise location 
and its context.  In addition to the basic 
task of locating a certain passage, it has 
many more complex textual analysis uses, 
including the useful indicator of the 
number of occurrences of each word and a 
browsable list of all the words. 

It is also lightning fast, unlike Acrobat, 
when dealing with all seven volumes.  Lo-
cating all instances of a single word is in-
stant in Concordance and can take up to a 
whole minute in Acrobat on a fast 
computer, and much longer on a slow one. 

From the opening screen, shown here, 
click on “Seven Volume Urtext 
Concordance”. 

Figure 15 The opening screen of the Abridged Concordance 

http://www.execulink.com/~dthomp75/2007/index.htm�
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Now I know this warning looks scary, but it is necessary for 
first time users to know that certain “BHOs” will screw up the 
Concordance, most notably those which look for phone 
numbers to link to your VOIP software, if you use VOIP 
software such as SKYPE. 

Because the Concordance has millions of “numbers” that 
look to the BHOs like phone numbers, even fast computers will 
stall right out as the BHO tries to turn a chapter and section 
reference into a number you can dial. 

It won’t actually damage your computer or your data but 
your computer will seem to ‘hang’ until millions of numbers 
are digested by such BHOs. 

If you use such software it must be toggled OFF for the 
Concordance to work.  This page explains how to do it. If you 
don’t use such software or you have switched it off, just click 
on the top line to bypass the warning.  Then you get to the 
following screen. 

It is further important to know that while the Concordance 
works slowly and clumsily with Internet Explorer it works 
much better with the Mozilla Firefox 2 browser, which is 
available as a free download.  This browser is highly 
recommended for the Concordances.
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This is the opening screen of the 

Concordance.  While the user 
interface is not as intuitive as it 
might be and is not graphical as I’d 
like, it is actually not complicated 
either and doesn’t take long to learn 
if you follow these instructions 
carefully. 

You see the screen is divided into 
four frames, a pale blue horizontal 
Navigator frame along the top, a 
vertical white Wordlist frame on the 
left, and two horizontal white 
background frames in the middle and 
lower right.  They are the 
Concordance frames and the Text 
frames.   

That will all make perfect sense 
in a few minutes. 

First, the Navigator frame is 
where you choose what you want to 
do and if we are here to SEARCH 
then we click on the first line: 
START New Search. Then 
follow the instruction and left click 
on any blank spot in the Wordlist 

(vertical frame on the left).  This is necessary to direct the search to that frame first.  Then press  
Control + F. Figure 16 Concordance opening screen where searching starts 
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Now we entered the word “teach” in the text 
search box (which shows up on the bottom left 
after we press Control+F) and then clicked on 
the highlighted word “TEACH (334)” in the 
Wordlist frame and then we see all instances of 
the that word, with five words of context on 
either side show up in the central Concordance 
frame (the uppermost of the two large frames).  
By clicking on the reference (blue numbers and 
letters to the right of each Concordance line) the 
Text frame at the bottom right will instantly 
scroll to that point in the Text. 

So to review: after pressing Control + F we 
enter the word we want to search for in the text 
search box and if we don’t see an immediate 
match, we press the “Next” green arrow to the 
right of the search box. 

Then, when the word we want shows up we 
click on that and all instances of that word, with 
context are displayed in the central Con-
cordance frame. 

 
 
 

Figure 17 initial search results                         
Now we have two choices, we can simply scroll through the list of “hits” in the central Concordance frame, or we can enter 

more words.  In this case I’m searching for “teach only love” so in the search box, now that I have got all lines in which the word 
“teach” appears, I can search for “teach only.” 



34 The Concordance 34 

 34

 

This is a good example to try.  As you 
type additional letters you will see Firefox 
jump to the next match of the partial search 
string.  Finally when I type “l” in “love” I 
find the one I want.  

On the lower line of the central Conco-
dance frame you can see it highlighted. 

On the right of that line (bottom line of 
central Concordance frame) I see that the 
reference is T 6 B 14 T(275).  Text, chapter 
6, section B, paragraph 14 on page 275 of 
the Urtext. 

If I’m here just to find the reference so 
as to look it up in the Notes, I have what I 
need, I have the reference now.  The Con-
cordance has done its job.  I can click on 
that reference and see that line of text in the 
Text frame, so let’s do that. 

Now you can see the line we were 
looking for highlighted in the lower right 
Text frame. 

Figure 18 finding the line we want in the Concordance frame.
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And there it is … the line I was searching for!  In this Text 

frame the whole of the seven volumes is included and 
exceptionally fast text searches for phrases or words are 
simple. 

If this description seems long and tedious and confusing and 
cumbersome, remember that it isn’t.  After you have any BHO 
issues dealt with and know which browser you’ll be using, you 
can click through the first entry screen in a second, then just 
click “Start New Search” and Control + F and enter what you 
are searching for.  In an instant you’ll find all instances of that 
word. 

With other options in the Navigator frame you can view a 
variety of help and documentation screens and you can click 
any letter to browse all headwords starting with that letter. 

With the page number or chapter/section/paragraph 
reference you can of course readily check the manuscript 
facsimile or the Notes facsimile to verify accuracy of the e-text 
found. This is generally a good idea because while there aren’t 
many mistakes in these copies, there still are a few.  I 
encourage you from here to just click on the various buttons in 
the Navigator frame and see what they do.  You’ll find there 
are many other ways of using this tool to search ACIM in 
various ways.  The “HELP” and “ABOUT” buttons also offer 
more extensive documentation.  We have done what we came 
to do, we have found and identified our reference.  The first 
time you use the software you’ll likely spend a few minutes 
sorting out BHO and Browser issues.  Once that process is 
sorted out, this kind of search can take 5 or ten seconds.
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17. Using the Concordance in Split Screen mode with Firefox 
We began by comparing 

two PDF documents using 
two Firefox windows and 
“tiling” them horizontally.  
We can do the same with the 
Concordance and a PDF file.  
We can tile two Firefox 
browser windows and have 
the Concordance in one and 
any of the PDF files in the 
other.  The screen shot here 
shows the result. 

We have the Use of Terms 
open to the beginning of 
section 5 in both.  The ad-
vantage of using the Concor-
dance rather than Acrobat 
Reader lies in the speed and 
flexibility of its searching 
features. 

While either can certainly 
be used, the Concordance is 
considerably more powerful 
and flexible in certain very 
important ways, a key one of  

 

Figure 19 Concordance and Notes PDFs in horizontal split screen browser display. As you can see, by splitting the screen,  
even a rather large screen in this example, you end up with only a few lines of each document, displayed over and under.                                                                                
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which is the near-instantaneous searching of all seven volumes 
and the superiority of the Firefox text search capability. When 
you search in Firefox, rather than entering a search string and 
then pressing return, Firefox jumps to the first instance of the 
first letter you type, and so-on, which results in dramatically 

faster searches and instant recognition when the string you’re 
typing is not present.  And Firefox can do this quickly over 
enormously large volumes of text. 

It is sometimes preferable to 
split the screen vertically.  This 
screen shot shows the previous 
horizontal view of the two 
browser windows when “tiled” 
vertically.  The Concordance is 
on the left, the PDF viewer within 
Firefox on the right.  You can see 
that we have somewhat more text 
visible on each side. 

To achieve this result, how-
ever, we have to close the “Book-
marks” sidebar in Acrobat Reader.  
Once we have used the “Book-
marks” to locate the section we 
want, closing it is not a serious 
disadvantage. 

Once again I wish to stress that 
for serious textual comparison 
work the split screen is no sub-
stitute for a dual-head hardware 
configuration with two monitors.  
Such a set-up allows you to have 
full pages of two documents dis- 

Figure 20 Concordance and Notes PDFs in split screen vertical display                                                                  played side by side in larger type. 
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The split-screen or “tiled” views do permit an adequate display 
of somewhat smaller portions of the pages but to achieve that dis-
play takes considerable fiddling whereas with two monitors, each 
one displays in “single screen” mode which requires no fiddling. 

Of course I am speaking only from my own experience and the 
setup which works best for one may not be the best for anyone 
else. 

The techniques of tiling windows on a single monitor are cer-
tainly usable to bring twin documents side by side for compari- 

son.  They are, however, rather clumsy when compared with the 
dual monitor option.  In my view these techniques are not suitable 
for serious or sustained document comparison.  If you plan on 
doing more than the occasional comparison, I strongly recom-
mend that you seriously consider obtaining a second monitor. 

The following screen shot shows the same windows as the 
previous figures, but this time spread over two monitors instead of 
squeezed onto one. No tiling or fiddling is required to achieve this 
view.  This is the way it comes up when two windows are opened. 

 

Figure 21 This “dual head” screen shot shows how much more you can get on your “desktop” by adding a second monitor. 
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18. In summary – get a second monitor 
When I first began document comparison I fiddled a 

great deal with various ways to get two documents on a small 
computer monitor side by side.  The results were never really 
satisfactory, and always “fiddly.”  My fiddling ended when a 
good friend told me about the ‘dual head’ two-monitor option 
in Windows XP.  When I discovered I could get a dual head 
video card and a spare used CRT monitor for a very modest 
price, I did so and I’ve never looked back.   

For some operations, such as simply composing a letter, 
for instance, or reading a single document, the second monitor 
has little use.  But as soon as you need to look something up, 
compare documents, or keep a tutorial or help window visible 
on one screen while you try to follow instructions on another, 
the benefits of this tool are enormous. 

In preparing this tutorial for people who will mostly be 
using single monitor computers, I’ve once again engaged in a 
great deal of fiddling to see how to do what this collection of 
documents is for: DOCUMENT COMPARISONS. 

Of course you can get two documents to display on one 
monitor but it takes a great deal more fiddling and in the end 
you have much smaller portions of the documents visible, and 
generally they are displayed in a smaller size. 

I cannot recommend that second monitor highly 
enough.  These days used CRT monitors, sometimes of very 

high quality, monitors which cost hundreds of dollars a few 
years ago, are often found in these parts for $20 or even less.  
Used dual head video cards cost about the same.  If you plan on 
doing any significant amount of document comparison, invest 
in the “right tools” and you will never regret it. 

With such tools it is really a snap to pop the Urtext e-
text up on one monitor, either in the PDFs on this CD or in the 
Concordance, search for the phrase you want, locate the refer-
ence and then pop the appropriate Notes volume up on the 
other monitor and quickly have the two in front of you, side by 
side.  But don’t take it from me, check out this article from PC 
World: 
http://pcworld.about.com/news/May252005id120707.htm?iam
=momma_100_SKD&terms=%22UltraMon%22  

That article also discusses a very useful bit of software, 
“UltraMon,” which makes it easier to use two monitors.  That’s 
a $40 expense, and well worth every penny. 

And when you are shopping for used monitors, get the 
very largest you can manage … with computer monitors and 
this kind of work in text comparison “bigger IS better.” 

Check out Figure 21 again.  That’s what I’m looking at.  
What are you looking at?

http://pcworld.about.com/news/May252005id120707.htm?iam=momma_100_SKD&terms=%22UltraMon%22�
http://pcworld.about.com/news/May252005id120707.htm?iam=momma_100_SKD&terms=%22UltraMon%22�
http://pcworld.about.com/gi/dynamic/offsite.htm?site=http://pcworld.com/downloads/file_description/0,fid,25475,00.asp�
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19. Obtaining Acrobat Reader 9 
If you don’t have Acrobat Reader 9, it’s 

available free at ADOBE.COM and I 
suggest you download and install it.  
Whether your installation is new or old, 
there are some tools in Acrobat which 
aren’t the defaults, which should be en-
abled for the kind of work we’re going to 
be doing. 

If you just installed Acrobat Reader 9, 
you’ll see something much like this 
screenshot when you click on the file: 

“3c MANUAL URTEXT E-TEXT v2.PDF” 

That file is the third option in the third 
column of the menu: Manual. 
                                                                                
 

 

 

 

 

 

 
Figure 22 Initial view of the e-text in Acrobat Reader 9, in this case showing the Manual for Teachers
 

http://www.adobe.com/products/acrobat/readstep2.html�
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20. Configuring Acrobat Reader 9 
There are a few changes from the default setup which I highly recommend, and I’ll show you how to do them.  I find Acrobat 

Reader’s “Bookmarks” sidebar is easier to use if it doesn’t wrap long names, especially with some of the huge Bookmark lists we’re 
using here. To turn “wrap” off, click on 
options (in the top right hand corner of the 
left hand sidebar) and then click on “Wrap 
Long Bookmarks.” 

The second change I recommend is to 
get the “Binoculars” ( ) icon into the 
toolbar.  This is for advanced searching.  
You can use File > Edit > Search or Shift 
Control + F, instead of the “Binoculars” 
icon but since we plan on using this for 
searching, we might as well get it down to 
one click. 

To set up the “binoculars” in Adobe 
Reader click on “Tools” on the top left and 
then “Customize Toolbar” and then scroll 
down the box you see as in the next 
screenshot to the File Toolbar section and 
then click on “Search” which is beside the 
binocular icon.  This will put the icon in 
your toolbar. 

 

 
Figure 23 Wrap Long Bookmarks 
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This is the “Tools” dialogue where we are 
going to select “Search” to get our 
“binoculars” icon on our toobar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 Figure 24, putting the “search” icon (binoculars ) in our toolbar in Adobe Reader 
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Now our screen looks a little different, I’m 
just going to show you the top half here 
where the Bookmarks look better and the 
“binocular” icon is there second from the 
left at the top. 

 

 
 

 

Figure 25, we’ve got the Bookmarks to stop wrapping and the “Search” tool in our toolbar. 
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The next set of alterations I’d suggest is 
the addition of the “First Page” and “Last 
Page” icons, which make navigation in 
large PDF files faster and easier.  In 
addition I suggest the “Fit Page” and “Fit 
Width” “Hand Tool” and “Pan and Zoom” 
tools. Click on “Tools” (top row of screen) 
and then “Customize Toolbars” and what 
you’ll see is shown in the screenshot. 

Of course this is not a full Acrobat tuto-
rial; just some tips for people new to the 
software to get you started using the MPF 
ACIM materials.  There are many other 
options you may wish to explore and make 
use of.  There may be some you know and 
we don’t that you’d like to share with us. 

Now we’re ready to use Acrobat to 
search the Notes! 

 

 
 

 
Figure 26 selecting First Page and Last Page Navigation Tool Icons
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